
 

 

  

第 1 章  

 
初识 Python 

Python 是一种跨平台的、开源的、免费的、解释型的高级编程语言。近几年 Python 发展势头迅猛，

在 2022 年 11 月的 TIOBE 编程语言排行榜中已经晋升到第 1 名，而在 IEEE Spectrum 发布的 2021 年度

编程语言排行榜中，Python 连续 5 年夺冠。另外，Python 的应用领域非常广泛，如 Web 编程、图形处

理、黑客编程、大数据处理、网络爬虫和科学计算等，Python 都可以实现。 

作为 Python 开发的起步，本章将先对学习 Python 需要了解的一些基础内容进行简要介绍，然后重

点介绍如何搭建 Python 开发环境，最后介绍常见的几种 Python 的开发工具。 

本章知识架构及重难点如下。 

 

1.1  Python 简介   

1.1.1  什么是 Python 

Python（发音[ˈpaɪθən] ）本义是指“蟒蛇”（这里需要

说明的是，Python 并不是以蟒蛇命名，而是以电视节目

Monty Python’s Flying Circus 来命名的），标志如图 1.1 所

示。它的设计理念为优雅、明确、简单。实际上，Python

也是按照这个理念做的，以至于现在网络上流传着“人生 图 1.1  Python 标志 
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苦短，我用 Python”的说法。可见 Python 有着简单、开

发速度快、节省时间和精力等特点。 

Python 本身并非所有的特性和功能都集成到语言核心

中，而是被设计为可扩充的。Python 具有丰富和强大的库，

能够把用其他语言（尤其是 C/C++）制作的各种模块很轻

松地联结在一起。为此，Python 常被称为“胶水”语言。 

在 1991 年 Python 的第一个公开发行版问世之后，

Python 的发展并不突出。自从 2004 年以后，Python 的使

用率呈线性增长。2010 年，Python 赢得 TIOBE 2010 年度

语言大奖。直到 2021 年，IEEE Spectrum 发布的年度编程

语言排行榜中，Python 已经连续 5 年夺冠，如图 1.2 所示。 

1.1.2  Python 的版本 

Python 自发布以来，主要经历了 3 个版本，分别是

1994 年发布的 Python 1.0 版本（已过时），2000 年发布的 Python 2.0 版本（已停止更新）和 2008 年发

布的 Python 3.0 版本（现在已更新到 3.11.x）。 

 

 

1.1.3  Python 能做什么 

Python 是一种功能强大，并且简单易学的编程语言，因而广受好评，那么 Python 能做什么呢？概

括起来有以下几个方面。 

1．Web 开发 

使用 Python 的一个基本应用就是进行 Web 开发。在国内，

大一些的使用 Python 做基础设施的公司有豆瓣、知乎、美团、

饿了么、搜狐等。在国外，Google 在其网络搜索系统中广泛应

用了 Python，并且聘用了 Python 之父。另外，YouTube 视频分

享服务大部分也是用 Python 编写的，如图 1.3 所示。 

2．大数据处理 

随着近几年大数据的兴起，Python 也得到了前所未有的爆发。Python 借助第三方的大数据处理框

架可以很容易地开发出大数据处理平台。到目前为止，Python 是金融分析、量化交易领域里使用最多

的语言之一。例如，美国银行就利用 Python 语言开发出了新产品和基础设施接口，用于处理金融数据。 

Python 版本更新较快，几乎两个月就升级一次，这也导致很多扩展库的发行总是滞后于 Python

的发行版本。因此，在选择 Python 时，一定要先考虑清楚自己的学习目的。例如，打算做哪方面的

开发，需要用到哪些扩展库，以及扩展库支持的最高 Python 版本等。明确这些问题后，再做出选择。

 

图 1.3  Web 开发应用 Python 的公司

图 1.2  2021 年度编程语言排行榜前 10 名 
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3．人工智能 

人工智能（artificial intelligence），英文缩写为 AI。Python 之所以这么火，主要是借助人工智能的

发展。Python 是一种脚本语言，它更适合做人工智能领域，因为在人工智能领域使用 Python 比其他编

程语言具有更大的优势。主要的优势在于，它简单、快速、可扩展（主要体现在可以应用多个优秀的

人工智能框架）等。另外，Python 中的机器学习可以实现人工智能领域中的大多数需求。 

4．自动化运维开发 

掌握一种开发语言已经成为高级运维工程师的必备技能。Python 是一种简单、易学的脚本语言，

它能满足绝大部分自动化运维的需求。对于通常不会开发的运维工程师来说，想学习一种开发语言，

Python 则是首选。 

5．云计算 

Python 可以广泛地在科学计算领域发挥独特的作用。Python 通过强大的支持模块可以在计算大型

数据、矢量分析、神经网络等方面高效率地完成工作，尤其是在教育科研方面，可以发挥出独特的优

势。从 1997 年开始，NASA 就在大量使用 Python 进行各种复杂的科学运算。现在终于发明了一套云

计算软件，取名为 OpenStack（开放协议栈），并且对外公开发布。 

6．网络爬虫 

网络爬虫（也称为 spider）始于也发展于百度、谷歌。但随着近几年大数据的兴起，爬虫应用被提

升到前所未有的高度。多数分析挖掘公司都以爬虫的方式得到不同来源的数据集合，最后为其所用，

进而构建属于自己的大数据综合平台。在爬虫领域，Python 几乎是霸主地位，通过它提供的标准支持

库基本上可以做到随意获取想要的数据。 

7．游戏开发 

使用 Python 完全可以编写出非常棒的游戏程序，例如，知名的游戏《文明 6》就是用 Python 编写

的。另外，Python 在网络游戏开发中也有很多应用。它作为游戏脚本被内嵌在游戏中，这样做的好处

是既可以利用游戏引擎的高性能，又可以受益于脚本化开发等优点。 

 

 

1.2  搭建 Python 开发环境   

1.2.1  开发环境概述 

所谓“工欲善其事，必先利其器”。在正式学习 Python 开发前，需要先搭建 Python 开发环境。由

于 Python 是跨平台的，它可以在多个操作系统上进行编程，并且编写好的程序可以在不同系统上运行。

常用的操作系统及其说明如表 1.1 所示。 

Python 的应用领域远比上面提到的多得多。例如，使用 Python 对图形/图像进行处理、编程控制

机器人、数据库编程、编写可移植的维护操作系统的工具，以及进行自然语言分析等。 
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表 1.1  进行 Python 开发常用的操作系统及其说明 

操 作 系 统 说  明 

Windows 推荐使用 Windows 10。另外，Python 3.9 及以上版本不能在 Windows 7 系统上使用 

Mac OS 从 Mac OS X 10.3（Panther）开始已经包含 Python 

Linux 推荐 Ubuntu 版本 

 

 

1.2.2  安装 Python 

要进行 Python 开发，需要先安装 Python 解释器。因为 Python 是解释型编程语言，所以需要一个

解释器，这样才能运行我们写的代码。这里说的安装 Python 实际上就是安装 Python 解释器。下面将以

Windows 操作系统为例介绍如何安装 Python。 

1．下载 Python 安装包 

在 Python 的官方网站中，可以很方便地下载 Python 的开发环境，具体下载步骤如下。 

（1）打开浏览器（如 Google Chrome 浏览器），进入 Python 官方网站，地址是 https://www.python. 

org/，如图 1.4 所示。 

 

图 1.4  Python 官方网站首页 

 

 

如果在单击 Windows 菜单项时没有显示右侧的下载按钮，则应该是页面没有加载完全，在加载

完成后就会显示，请耐心等待。 

在个人开发学习阶段推荐使用 Windows 操作系统。本书采用的就是 Windows 操作系统。 

 将鼠标移动到

Downloads 菜单上

 单击 Windows 菜单项

如果是 64 位系统，可以通过

该快捷下载按钮进行下载 



Python 从入门到精通（第 3 版） 

 
6 

（2）将鼠标移动到 Downloads 菜单上，将显示与下载有关的菜单项。如果使用的是 64 位的 

Windows 操作系统，那么直接单击 Python 3.11.x 按钮下载 64 位的安装包；否则，单击 Windows 菜单

项，进入详细的下载列表中。在下载列表中，将列出 Python 不同版本的下载链接，读者可以根据需要

进行下载。这里单击 Windows 菜单项，进入如图 1.5 所示的下载列表中。 

 

图 1.5  适合 Windows 操作系统的 Python 下载列表 

 

 

（3）在 Python 下载列表页面中，将列出 Python 提供的各个版本的下载链接，读者可以根据需要进

行下载。当前 Python 3.x 的最新稳定版本是 3.11.0。在图 1.5 中单击 Download Windows installer (64-bit)

超链接，下载适用于 Windows 64 位操作系统的离线安装包，如图 1.6 所示。 

 

图 1.6  正在下载 Python 

 

 

在如图 1.5 所示的列表中：带(32-bit)的超链接，表示它在 Windows 32 位操作系统上使用；带(64-bit)

的超链接，表示它在 Windows 64 位操作系统上使用。另外：标记为 embeddable package 的超链接，

表示嵌入式安装；标记为 installer 的超链接，表示通过可执行文件（*.exe）方式进行离线安装；标记

为 embeddable zip file 的超链接，表示可以集成到其他应用中的嵌入式版本。 

Python 3.11.x版本需要在Windows 10及以上操作系统上进行安装，如果您的操作系统是Windows 

10 以下版本，那么可以在下载列表页面中下载 Python 3.8.x 版本。 

下载 32 位操作系统的离线安装包

下载 64 位操作系统的离线安装包

正在下载 
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（4）下载完成后，浏览器会自动提示“此类型的文件可能会损害您的计算机。您仍然要保留

python-3.11.0-am….exe 吗？”，此时，单击“保留”按钮，保留该文件即可。 

（5）下载完成后，将得到一个名称为 python-3.11.0-amd64.exe 的安装文件。 

2．在 Windows 64 位系统上安装 Python 

在 Windows 系统上安装 Python 3.x 的步骤如下。 

（1）双击安装文件 python-3.11.0-amd64.exe，将显示安装向导对话框，选中 Add python.exe to PATH

复选框，表示将自动配置环境变量，如图 1.7 所示。 

 

图 1.7  Python 安装向导 

 
 

 

（2）单击 Customize installation 按钮，进行自定义安装（自定义安装可以修改安装路径），这里采

用默认设置，如图 1.8 所示。 

 

图 1.8  设置要安装的选项对话框 

一定要选中 Add python.exe to PATH 复选框，否则在后面学习中会出现“XXX 不是内部或外部

命令”的错误。 

误区警示 

默认安装，路径不能修改，

建议不要安装在该目录下

 选择自定义安装 

 选中该复选框

安装 Python 帮助文档

安装下载 Python 包的工具 

安装 Tkinter 和 IDLE 开发环境 

安装标准库测试套件 安装所有用户都可以

启动Python的发射器 

单击该按钮 
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（3）单击 Next 按钮，在打开的高级选项对话框中，设置安装路径为 C:\Python\Python311，其他

采用默认设置，如图 1.9 所示。 

（4）单击 Install 按钮，将开始安装 Python，并且显示安装进度。在安装完成后，将显示如图 1.10

所示的对话框。 

  

图 1.9  高级选项对话框                                 图 1.10  安装完成对话框 

 

 

3．测试 Python 是否安装成功 

Python 安装成功后，需要检测 Python 是否真的安装成功。例如，在 Windows 10 系统中检测 Python

是否真的安装成功，可以在“开始”菜单

右侧的“在这里输入你要搜索的内容”文

本框中输入 cmd 命令，然后按 Enter 键，

启动“命令提示符”窗口，再在当前的命

令提示符后面输入 python，并按 Enter 键，

如果出现如图 1.12 所示的信息，则说明

Python 已安装成功，同时也进入交互式

Python 解释器中。 

图 1.12 中的信息是关于笔者计算机中安装的 Python 的信息，其中包括 Python 的版本、该版本发

行的时间、安装包的类型等信息。因此，如果读者计算机中安装的关于 Python 的信息与此信息不完全

相同也没关系，只要命令提示符变为>>>，就说明 Python 已经准备就绪，正在等待用户输入 Python 命

令。这也表示 Python 已安装成功。 

安装 Python 时，有时可能会出弹出如图 1.11

所示的错误提示对话框，并且不能再继续安装。 

出现该错误的原因是权限设置的问题。解决

方法是，在安装包文件上右击，在弹出的快捷菜

单中单击“以管理员身份运行”菜单项，再继续

安装即可。 
图 1.11  出现 2503 错误提示对话框 

 

图 1.12  在“命令提示符”窗口中运行的 Python 解释器 

更改 Python 的安装路径

单击该按钮 

误区警示 
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1.2.3  编写第一个 Python 程序 

作为程序开发人员，学习新语言的第一步就是输出 Hello World。学习 Python 开发也不例外，我们

也是从 Hello World 开始的。在 Python 中，可以通过以下两种方法编写 Hello World 程序。 

1．在“命令提示符”窗口启动的 Python 解释器中实现 

【例 1.1】在“命令提示符”窗口启动的 Python 解释器中实现第一个 Python 程序。（实例位置：

资源包\TM\sl\01\01） 

在“命令提示符”窗口启动的 Python 解释器中编写 Python 程序非常简单方便，下面是编写第一个

程序 Hello World 的具体步骤。 

（1）在“开始”菜单右侧的“在这里输入你要搜索的内容”文本框中输入 cmd 命令，并按 Enter 键，

启动“命令提示符”窗口。然后在当前的 Python 提示符后面输入 python，并按 Enter 键，进入 Python

解释器中。 

（2）在当前的 Python 提示符>>>的右侧输入以下代码，并按 Enter 键： 
 
print("Hello World") 
 

 

 

运行结果如图 1.13 所示。 

2．在 Python 自带的 IDLE 中实现 

通过例 1.1 可以看出，在“命令提示符”窗口

的 Python 解释器中，编写 Python 代码时，代码颜

色是纯色的，不方便阅读。实际上，在安装 Python

时，会自动安装一个开发工具 IDLE，通过它编写

Python 代码时，将会用不同的颜色显示代码。这样

代码将更容易阅读。下面将通过一个具体的例子演示如何打开 IDLE，并编写 Hello World 程序。 

【例 1.2】在 IDLE 中实现第一个 Python 程序。（实例位置：资源包\TM\sl\01\02） 

在 Python 自带的 IDLE 中编写 Python 程序同样非常简单方便，下面是编写第一个程序 Hello World

的具体步骤。 

（1）单击 Windows 10 系统的“开始”菜单，然后依次单击“所有程序”→Python 3.11→IDLE   

如果输入 python 后，没有出现如图 1.12 所示的信息，而是显示“‘python’不是内部或外部命

令，也不是可运行的程序或批处理文件。”那么需要在环境变量中配置 Python。 

在上述代码中，一对小括号()和双引号""都必须在英文（即半角）状态下输入，并且 print 全部为

小写字母。因为 Python 的语法是区分字母大小写的。 

图 1.13  在“命令提示符”窗口中输出 Hello World
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（Python 3.11 64-bit）菜单项，即可打开 IDLE 窗口，如图 1.14 所示。 

 

图 1.14  IDLE 窗口 

（2）在当前的 Python 提示符>>>的右侧输入以下代码，并按 Enter 键： 
 
print("Hello World") 
 
运行结果如图 1.15 所示。 

 

图 1.15  在 IDLE 中输出 Hello World 

 
 

 

1.2.4  运行已经编写好的.py 文件 

在 1.2.3 节中已经介绍了如何在 Python 交互模式中直接编写并运行 Python 代码。这里，如果已经

编写好一个.py 的 Python 文件，那么应该如何运行它呢？ 

要运行一个已经编写好的.py 文件，可以在“开始”菜单右侧的“在这里输入你要搜索的内容”文

本框中输入 cmd 命令，并按 Enter 键，启动“命令提示符”窗口，然后按照以下格式输入代码： 
 
python 完整的文件名（包括路径） 

如果在中文（即全角）状态下输入代码中的小括号()或者双引号""，那么将产生语法错误。例

如，在 IDLE 开发环境中输入下列代码（其中，括号()和双引号""是在中文状态下输入的）： 
 
print（“Hello World”） 
 
按 Enter 键运行后，将会出现如图 1.16 所示的错误提示。 

 

图 1.16  在中文状态下输入小括号和双引号时出现的错误 

误区警示 

输入的 Python 代码，其中

print()方法用于输出信息
输出的信息

Python 提示符，表示 Python 已经准

备好，等待用户输入 Python 代码 
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例如，要运行 D:\demo.py 文件，可以使用以下代码： 
 
python D:\demo.py 
 
运行结果如图 1.17 所示。 

 

 

1.3  Python 开发工具   

通常情况下，为了提高开发效率，需要使用相应的开发工具。进行 Python 开发也可以使用开发工

具。下面将详细介绍 Python 自带的 IDLE 和其他常用的第三方开发工具。 

1.3.1  使用自带的 IDLE 

在安装 Python 后，会自动安装一个 IDLE。IDLE 是一个 Python Shell（可以在打开的 IDLE 窗口的

标题栏上看到），也就是一个通过输入文本与程序交互的途径，程序开发人员可以利用 Python Shell 与

Python 进行交互。下面将详细介绍如何使用 IDLE 开发 Python 程序。 

1．打开 IDLE 并编写代码 

打开 IDLE 时，在“开始”菜单中单击“所有程序”→Python 3.11→IDLE（Python 3.11 64-bit）菜

单项，即可打开 IDLE 主窗口，如图 1.18 所示。 

 

图 1.18  IDLE 主窗口 

在 1.2.3 节中，我们已经应用 IDLE 输出了 Hello World，但是在实际开发时，通常不能只包含一行

代码，如果需要编写多行代码，可以单独创建一个文件保存这些代码，然后在全部代码编写完毕后，

可一起执行。具体方法如下。 

在运行.py 文件时，如果文件名或者路径比较长，

可先在“命令提示符”窗口中输入 python 加一个空格，

然后直接把文件拖曳到空格的位置上，这时文件的完

整路径将显示在空格的右侧，再按 Enter 键运行。 
 

图 1.17  在 Python 交互模式下运行.py 文件 

菜单栏 

Python 提示符，表

示 Python 已经准备

好，等待用户输入

Python 代码 

与版本相关的信息，

主要用于提示当前 
Python 的版本 
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（1）在 IDLE 主窗口的菜单栏上，单击 File→New File 菜单项，将打开一个新窗口，在该窗口中，

可以直接编写 Python 代码，并且在输入一行代码后按 Enter 键，将自动换到下一行，等待继续输入，

如图 1.19 所示。 

（2）在代码编辑区中，编写多行代码。例如，输出古诗《长歌行》，代码如下： 
 
01 print("        "+"长歌行") 
02 print("青青园中葵，朝露待日晞。") 
03 print("阳春布德泽，万物生光辉。") 
04 print("常恐秋节至，焜黄华叶衰。") 
05 print("百川东到海，何时复西归。") 
06 print("少壮不努力，老大徒伤悲。") 
 
编写代码后的 Python 文件窗口如图 1.20 所示。 

        

图 1.19  新创建的 Python 文件窗口               图 1.20  编写代码后的 Python 文件窗口 

（3）按 Ctrl+S 快捷键保存文件，这里将其保存为 demo.py。其中，.py 是 Python 文件的扩展名。 

（4）运行程序。在菜单栏中单击 Run→Run Module 菜单项，如图 1.21 所示。 

运行程序后，将在 Python Shell 窗口中显示执行结果，如图 1.22 所示。 

         

图 1.21  运行程序                              图 1.22  运行结果 

 

 

2．IDLE 常用的快捷键 

在程序开发过程中，合理地使用快捷键不仅可以减少代码的错误率，还可以提高开发效率。因此，

掌握一些常用的快捷键是必需的。在 IDLE 中，可通过单击 Options→Configure IDLE 菜单项，在打开

的 Settings 对话框的 Keys 选项卡中查看常用的快捷键，但是该界面是英文的，不便于查看，因此笔者

当需要运行程序时，也可以直接按 F5 键。 

标题栏，untitled 表示未命名

代码编辑区，可以输

入多行 Python 代码 

带*号表示文件未保存 

编写的代码
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通过表 1.2 列出了一些常用的快捷键，可方便读者查看。 

表 1.2  IDLE 提供的常用快捷键 

快  捷  键 说    明 适  用  于 
F1 打开 Python 帮助文档 Python 文件窗口和 Shell 窗口均可用 

Alt+P 浏览历史命令（上一条） 仅 Python Shell 窗口可用 

Alt+N 浏览历史命令（下一条） 仅 Python Shell 窗口可用 

Alt+/ 

自动补全前面曾经出现过的单词。如果之前有多个

单词具有相同的前缀，则可以连续按该快捷键，在

多个单词中循环来选择单词 

Python 文件窗口和 Shell 窗口均可用 

Alt+3 注释代码块 仅 Python 文件窗口可用 

Alt+4 取消代码块注释 仅 Python 文件窗口可用 

Alt+g 转到某一行 仅 Python 文件窗口可用 

Ctrl+Z 撤销一步操作 Python 文件窗口和 Shell 窗口均可用 

Shift+Ctrl+Z 恢复上一次的撤销操作 Python 文件窗口和 Shell 窗口均可用 

Ctrl+S 保存文件 Python 文件窗口和 Shell 窗口均可用 

Ctrl+] 缩进代码块 仅 Python 文件窗口可用 

Ctrl+[ 取消代码块缩进 仅 Python 文件窗口可用 

Ctrl+F6 重新启动 Python Shell 仅 Python Shell 窗口可用 

  

 

1.3.2  使用 Visual Studio Code 

除 Python 自带的 IDLE 外，还有很多能够进行 Python 编程的开发工具。Visual Studio Code（简称

VS Code）是微软（Microsoft）在 2015 年 4 月 30 日正式宣布的一个可以在 Mac OS X、Windows 和 Linux

系统中运行的、免费开源的、跨平台的代码

编辑器，该编辑器支持多种语言和文件格式

的编写，截至 2019 年 9 月，已经支持了 37

种语言。Visual Studio Code 代码编辑器的

启动和运行速度都很快。 

1．下载与安装 Visual Studio Code 

打开 Visual Studio Code 官网下载地址

（https://azure.microsoft.com/zh-cn/products/

visual-studio-code/），在网页中单击“立即

下载”按钮，如图 1.23 所示。 

在下载页面中根据计算机系统版本下

载对应的 Visual Studio Code，如图 1.24 所

由于 IDLE 简单、方便，很适合练习，本书将以 IDLE 作为开发工具。 

图 1.23  下载 Visual Studio Code 

单击该按钮 
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示。因为笔者使用的是 Windows 64 位系统，所以将以该版本进行演示。 

 

图 1.24  下载 Windows 版本的 Visual Studio Code 

下载完成以后，打开 VSCodeUserSetup-x64-x.xx.x.exe 安装文件，接着在安装对话框中选中“我同

意此协议”单选按钮，然后单击“下一步”按钮，如图 1.25 所示。 

在“选择目标位置”对话框中，单击“浏览”按钮，选择 Visual Studio Code 的安装位置，单击“下

一步”按钮，如图 1.26 所示。 

   

图 1.25  选中“我同意此协议”单选按钮                图 1.26  选择 Visual Studio Code 的安装位置 

下载Windows系
统对应的版本 

正在下载

 选中此单选按钮 

 单击该按钮 

 选择安装位置 

 单击该按钮 

 单击该按钮
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在“选择开始菜单文件夹”对话框中，单击“下一步”按钮，如图 1.27 所示。 

在“选择附加任务”对话框中，选中“创建桌面快捷方式”复选框，然后单击“下一步”按钮，

如图 1.28 所示。 

   

图 1.27  选择开始菜单文件夹                             图 1.28  创建桌面快捷方式 

在“准备安装”对话框中，单击“安装”按钮，如图 1.29 所示。 

单击“安装”按钮后，将显示如图 1.30 所示的安装进度对话框。 

  

图 1.29  准备安装                                 图 1.30  安装进度对话框 

安装完成以后将显示如图 1.31 所示的“安装完成”对话框，在该对话框中单击“完成”按钮即可。 

2．配置 Visual Studio Code 

Visual Studio Code 启动后，单击左侧的 Extensions 按钮，安装 Python 插件，具体操作步骤如     

图 1.32 所示。 

Python 插件安装完成后，右侧将显示如图 1.33 所示的 Python 扩展界面。 

单击该按钮 

 选中此复选框 

 单击该按钮 

单击该按钮 
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图 1.31  安装完成 

 

图 1.32  安装 Python 插件 

 

图 1.33  Python 扩展界面 

在自定义的目录下创建一个文件夹，作为 Visual Studio Code 开发工具的项目结构目录。例如，在

 选中该复选框

 单击Extensions按钮

 搜索 Python 插件

 单击 Install按钮

Python 扩展

 单击该按钮
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D 盘下创建一个名称为 PythonProject 的文件夹。单击左上角 File→Open Folder 菜单项，然后选择已经

创建的 PythonProject 文件夹，如图 1.34 所示。 

   

图 1.34  打开文件夹 

单击左侧 Explorer 选项，然后在项目文件夹 PYTHONPROJECT 中单击 New File 按钮，创建一个

demo.py 的 Python 文件，如图 1.35 所示。 

 

图 1.35  创建 demo.py 文件 

单击刚刚创建的 demo.py 文件，然后在右侧的编辑区域编写测试代码，最后单击右上角的“运行”

按钮，如图 1.36 所示。 

 

图 1.36  应用 Visual Studio Code 运行 Python 代码 

 单击 File 菜单 

 单击 Open Folder 菜单项

 选择 D 盘

 选择文件夹

 单击该按钮

 单击该选项  单击该按钮 

 创建 demo.py 文件 

代码高亮显示 

运行结果

单击“运行”按钮
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3．汉化 Visual Studio Code 

Visual Studio Code 插件功能也是非常丰富的，读者如果无法适应全英文状态下的开发工具，则可

以在 Extensions（扩展）功能中搜索中文汉化插件，如图 1.37 所示。 

 

图 1.37  搜索中文汉化插件 chinese 

中文插件安装后，重新启动 Visual Studio Code 开发工具，将显示如图 1.38 所示的中文窗口。 

 

图 1.38  汉化后的中文窗口 

Visual Studio Code 的 Python 扩展支持 Python 语言的智能提示、Linting、调试、代码导航、代

码格式化、重构，以及结合 Jupyter Notebook 一起开发等。 

 单击 Extensions 按钮

 搜索 chinese 插件 

 选择“中文简体”插件

 安装插件
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PyCharm 的官方网站为 http://www.jetbrains.com/pycharm/，该网站提供了两个版本的 PyCharm：

一个是社区版（免费并且提供源程序）；另一个是专业版（免费试用）。读者可以根据需要选择下

载版本。 

1.3.3  常用的第三方开发工具 

1．PyCharm 

PyCharm 是由 JetBrains 公司开发的一款 Python 开发工具。它在 Windows、Mac OS 和 Linux 操作

系统中都可以使用。它具有语法高亮显示、Project（项目）管理代码跳转、智能提示、自动完成、调

试、单元测试和版本控制等一般开发工具都具有的功能。另外，PyCharm 还支持在 Django（Python 的

Web 开发框架）框架中进行 Web 开发。PyCharm 的主窗口如图 1.39 所示。 

 

图 1.39  PyCharm 的主窗口 

 

 

 

 

2．Sublime Text 

Sublime Text 是一款跨平台代码编辑器（code editor）软件。Sublime Text 既可以编写代码，又可以

编辑文本，是程序员必不可少的工具。另外，Sublime Text 支持代码高度显示、代码补全、多窗口、即

时项目切换、自定义皮肤等功能，同时也支持多种编程语言和多种操作系统。应用 Sublime Text 3 开发

的 Python 界面如图 1.40 所示。 

代码高亮显示 

智能提示
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图 1.40  应用 Sublime Text 3 开发的 Python 界面 

1.4    实践与练习 

                                            （答案位置：资源包\TM\sl\01\实践与练习） 

综合练习 1：输出金一南教授的话  国防大学教授金一南在“我们的时代，我们的奋斗”演讲中   

说：“数十年走来，我今天跟大家分享三点体会：做有心人，干困难事，立大格局。”那么现在我们就

在 PyCharm 中输出金一南教授的这三点体会。 

综合练习 2：输出程序员节“1024”的含义  10 月 24 日，是中国程序员共同的节日—程序员节。

1024 是一个很特殊的数字，在计算机操作系统里，1024 Byte（字节）=1 KB，1024 KB =1 MB，1024 MB = 1 GB

等。程序员就像是一个个 1024，以最低调、踏实、核心的功能模块搭建起这个科技世界。请大家开动

脑筋，输出 1024 也就是程序员节的核心含义。参考以下形式，也可以自创其他形式。 
 
1024（程序员之日）寓意： 
   低调、踏实、核心 
1024 MB=1 GB，谐音一级棒 

 

 




